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Population Dynamics 
As organisms reproduce, die, and move in and out of an area, their populations fluctuate. In a 
closed population, organisms do not move in and out of an area, so their populations change only 
through natality, or births, and mortality, or deaths of individuals. Yeast are very small, rapidly 
reproducing organisms. They can experience dramatic population changes over a relatively short 
time. In this experiment, a population of yeast will be given a small amount of food and placed 
in a closed environment. Organic materials will not enter or leave the environment—only 
inorganic gases will be allowed to be exchanged. The population of yeast can be monitored by 
measuring the turbidity, or cloudiness, of the medium that contains the yeast. 

To measure the yeast population, you will be using the Colorimeter or Spectrometer. In this 
device, light from an LED light source will pass through the medium containing yeast and strike 
a photocell. Photons of light that strike a yeast cell will be reflected away from the photocell and 
will make the medium appear more turbid. The Colorimeter or Spectrometer monitors the light 
received by the photocell as either an absorbance or a percent transmittance value. The 
absorbance value is proportional the population of yeast present in the medium. 

 
OBJECTIVES 
In this experiment, you will 

• Use a Colorimeter or Spectrometer to monitor a closed population of yeast. 
• Use a microscope to monitor a closed population of yeast. 
• Compare the population estimates obtained using the two different techniques.  
• Practice making dilutions for population counts.  

 
 
MATERIALS 

computer dropper pipet or Beral pipet 
Vernier computer interface* glass-marking pencil 
Logger Pro graph paper
Colorimeter or Spectrometer microscope
18 × 150 mm test tubes microscope slide and cover slip
cuvette and lid test-tube rack
two 5 mL pipettes or 10 mL graduated 
cylinders 

cotton swabs 

         * Not necessary if using a Spectrometer. 
 
 
PRE-LAB ACTIVITY 
Your instructor will be placing a small amount of yeast in a closed environment containing food 
at the start of the experiment. Use the Draw Prediction feature found under the Analyze menu to 
predict how the yeast population might change over a long time period  
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PROCEDURE 
Prepare the computer and Colorimeter or Spectrometer 

If instructed to do so by your teacher, one team should prepare the computer and Colorimeter or 
Spectrometer for use. The equipment will be located on a resource table for use by all of the 
class teams. 

 1. Prepare a blank by filling a cuvette 3/4 full with distilled water. To correctly use a cuvette, 
remember: 
• Wipe the outside of each cuvette with a lint-free tissue. 
• Handle cuvettes only by the top edge of the ribbed sides. 
• Dislodge any bubbles by gently tapping the cuvette on a hard surface. 
• Always position the cuvette so the light passes through the clear sides. 

 
Spectrometer Users Only (Colorimeter users proceed to the Colorimeter section) 

 2. Calibrate the Spectrometer. 
a. Use a USB cable to connect the Spectrometer to your computer. Choose New from the 

File menu. 
b. To calibrate the Spectrometer, place the blank cuvette into the cuvette slot of the 

Spectrometer, and choose Calibrate ►Spectrometer from the Experiment menu.  
c. The calibration dialog box will display the message: “Waiting 90 seconds for lamp to 

warm up.” After 90 seconds, the message will change to “Warmup complete.” Click 
Finish Calibration and then click .  

 
 3. Select the optimum wavelength for creating a standard growth curve. 

a. Click . A full spectrum graph of the solution will be displayed. Click  to 
complete the analysis. 

b. To select a wavelength for analysis, click the Configure Spectrometer Data Collection 
icon, , in the toolbar. 

c. Select Absorbance vs. Concentration (under the Collection Mode).  
d. Click Clear Selection under the list of available wavelengths. 
e. Choose the wavelength value closest to 600 nm in the list of wavelengths and then click 

. Remove the cuvette from the Spectrometer and dispose of the solution as 
directed.  

f. Proceed to Step 4. 
 
Colorimeter Users Only 
2. Connect the Colorimeter to the computer interface. Prepare the computer for data collection 

by opening the file “13 Population Dynamics” from the Biology with Vernier folder of 
Logger Pro. 
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 3. Calibrate the Colorimeter. 
a. Open the Colorimeter lid.  
b. Holding the blank cuvette by the upper edges, place it in the cuvette slot of the 

Colorimeter. Close the lid. 
c. Press the < or > button on the Colorimeter to select a wavelength of 565 nm (Green) for 

this experiment. Note: If your Colorimeter has a knob to select the wavelength instead of 
arrow buttons, ask your instructor for calibration information. 

d. Press the CAL button until the red LED begins to flash, then release. When the LED stops 
flashing, the calibration is complete. Proceed to Step 4. 

 
Measure the yeast population (Day 0) 

Each team should perform the following steps.  

4. Obtain a 2.5 mL yeast sample and control sample from your instructor. Add 2.5 mL of 
distilled water to the sample to dilute it 50%.  

5. Mix and transfer 2.5 mL of the diluted yeast into a clean, dry cuvette. Place a cuvette lid on 
the cuvette. Put an identifying mark on the bottom of the cuvette. Use this same cuvette each 
time you take readings.  

6. You are now ready to collect absorbance data for the yeast. Quickly perform these steps: 
a. Mix the cuvette contents until all air bubbles are removed from the clear sides of the cuvette. 
b. Wipe the outside of the cuvette with a tissue and place it into the device (close the lid if 

using a Colorimeter).  
c. Wait for the absorbance value in the meter to stabilize. 
d. Record the absorbance value in Table 2.  
e. Remove the cuvette from the device.  

 
7. Repeat Steps 5–6 for the control test tube.  

8. Record your absorbance values for the experimental test tube and the control test tube on the 
board, as instructed by your teacher. Discard the highest and lowest values and average the 
remaining absorbance values from all the class teams. Record the class average in Table 2. 

Measure the yeast population with a Microscope (Day 0) 

 9. Mix the yeast in the cuvette. 

 10. Using a dropper pipet, withdraw a small amount of culture and transfer one drop (or the 
amount specified by your instructor) onto a clean microscope slide. 

 11. Place a clean cover slip over the culture. Do not allow air bubbles to get trapped. The liquid 
should barely fill the area under the coverslip, but should not ooze out. 

 12. Place the slide on a microscope and focus it under low power. Refocus near the center of the 
slide under high (40×–45×) power. If there are too many cells to count, you will need to 
make a dilution. If a dilution must be made, follow the steps below. If not, proceed to 
Step 13. 
a. Mix the yeast in the test tube used to make the latest dilution and transfer 0.5 mL of yeast 

into a clean, dry test tube. 
b. Add 4.5 mL of water to the 0.5 mL of yeast. This will make a 1/10 dilution. 
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c. Mix the contents thoroughly. 
d. Record the dilution in your notebook. 
e. Repeat Step 10. 

 
 13. Record the final dilution of yeast. If undiluted, then record 1/1. If one dilution was made, 

record 1/10. If two dilutions were made, then record 1/100 (1/10 × 1/10). 

 14. Have one team partner count the number of yeast cells in one field of view. Be sure to count 
each cell—a yeast bud counts as a cell. If you see a clump of cells, estimate the number of 
cells in the clump. Record the appearance of the yeast cells and the odor of the tube in your 
notebook. 

 15. Calculate the count of yeast in the original sample. To do this, divide the final count of yeast 
by the dilution factor. Divide this value by 1/2⎯the dilution factor from Step 5⎯to obtain 
the final result. Record the result in Table 2. 

 16. Move the slide to a different field of view. Have another team member count the number of 
yeast cells in this field of view. Repeat this for every member of the team. Count the yeast in 
at least 6 fields.  

 17. Discard the highest and lowest count. Average the remaining values from all of the team 
members and record the average value in Table 2 and on the board. 

 18. Repeat Steps 10 – 17 for the control test tube.  

Measure the yeast population (Day 1–8) 

 19. Repeat Steps 1–18 for both test tubes each day, except the weekends, until the 9th day.  

 20. Your instructor may give you data from other classes to increase the number of data points in 
this experiment. If so, extend Table 2 in your notebook. 

 
DATA 

Table 1 

Prediction Plot 
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Table 2 

Day Absorbance Microscopic Count 

 Team data Class average Team data Class average 

 Expt Control Expt Control Expt Control Expt Control 

0         

1         

2         

3         

4         

5         

6         

7         

8         
 
 
PROCESSING THE DATA 

 1. Go to Page 2 of the experiment file to manually enter the absorbance values for the 
experimental data. Colorimeter users will already have this file open. Spectrometer users 
need to open the file “13 Population Dynamics” from the Biology with Vernier folder of 
Logger Pro.  
a. Enter the absorbance values for your team in Column 2 of Data Set 1of the data table. 
b. Enter the absorbance values for the control data your team measured in Column 3 of the 

data table. 
c. Enter the class average experimental absorbance values in Column 4 of the data table. 
d. Enter the class average control absorbance values in Column 5 of the data table. 

 
2. Use Text Annotation from the Insert menu to appropriately identify each of the four different 

lines on the graph. 

3. On Page 3 of the experiment file, manually enter the count values for the experimental data. 

a. Enter the count values for your team in Column 2 Data Set 2 of the data table. 
b. Enter the count values for the control data your team measured in Column 3 of the data 

table. 
c. Enter the class average experimental microscopic count values in Column 4 of the data 

table. 
d. Enter the class average control microscopic values in Column 5 of the data table. 

 
4. Use Text Annotation from the Insert menu to appropriately identify each of the four lines on 

the graph. 
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QUESTIONS 
1. Compare the plot of yeast population obtained from the absorbance readings with that from a 

microscopic count. Describe the similarities and differences among the plots. 

2. How do your results compare to that obtained from the class average? If there are any 
differences, explain how the differences might have occurred. 

3. What was the purpose of the control test tube? 

4. How do the results from the control test tube compare with those from the experimental test 
tube? What information does this provide? 

5. Could you tell whether a yeast cell was dead or alive during this experiment? How might this 
affect your results? 

6. What factors encouraged the growth of yeast in this experiment? Explain. 

7. What factors limited the growth of yeast in this experiment? Explain. 

8. How did your prediction compare with your results? How did your prediction compare with 
the results from the class average? Explain. 

9. How did the odor in the tube change throughout the experiment? What do you think was 
responsible for any changes? 

 
EXTENSIONS 
1. Design and perform an experiment to determine the effect temperature has on the growth rate 

of yeast. 

2. Design and perform an experiment to determine the effect different growth media have on 
the rate of growth for yeast. Consider growing them in plain water or in media with specific 
sugars as a food source. 

 



 
 
 

Vernier Lab Safety Instructions Disclaimer 
 
 

THIS IS AN EVALUATION COPY OF THE VERNIER STUDENT LAB. 
 
 
This copy does not include:  

 Safety information 
 Essential instructor background information 
 Directions for preparing solutions 
 Important tips for successfully doing these labs 

 
The complete Biology with Vernier lab manual includes 31 labs and essential teacher 
information. The full lab book is available for purchase at: 
http://www.vernier.com/cmat/bwv.html 
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